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About Your Assistant Collaboration 
Module 

The Your Assistant Collaboration Module is designed to help you overcome physical barriers when 
presenting information to other users who are connected to the Internet.  

The Your Assistant Collaboration Module client is an online conferencing application that assists 
with real world business needs. It is designed to help you conduct online meetings and 
presentations, and to provide interactive support and training. The Your Assistant Collaboration 
Module delivers information, including user presence, documents, desktop views, annotation, chat, 
video conferencing data and all other conferencing information between users in real time.  

This manual is designed to help you manage your collaborations.  

About this User Guide 
This guide contains information about the Mitel Your Assistant Collaboration Module features. It is 
assumes you have: 

• Familiarity with Graphical User Interfaces (GUIs). 
• An understanding of the Windows Operating System. 

System Requirements 
The hardware and software you need to use the Your Assistant Collaboration Module depends 
upon the role you wish to take during conferences.  

Conference attendees belong to one of three groups - Hosts, Presenters, and Participants. Hosts, 
who create and lead conferences, require the most system resources. Presenters use the sharing 
features to lead presentations, and therefore have higher video requirements than the attendees, 
who view the conference. These roles are not fixed. You may choose to host, present or attend a 
conference, but you should be aware that the system requirements differ for each role.  

Computers to be used for all roles require the following: 
• One of the following browsers: 

o Microsoft® Internet Explorer v5.0 or later 
o Firefox v1.5 or later 
o Netscape v7.0 or later 
o Opera v8.5 or later 

• URL, static IP address, or fully qualified domain name of the Your Assistant Collaboration 
server. 

It is important to ensure that your computer has all the necessary components and security 
privileges before entering a conference session. The following requirements must be met: 

• All the necessary service packs and drivers must be installed (applies to Presenters and 
Hosts only). 

• Internet Explorer security settings are set to Medium (or more permissive), or the equivalent 
for other browsers. 

• If the workstation sits behind a Proxy server (such as Microsoft ISA server), the proxy client 
must be installed on the workstation. 
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Host 

Most of the work is executed on the Host and Presenter's computers, so it is important that these 
workstations have the most power. One of the most useful additions to a Host or Presenter 
workstation is an accelerated video card, which will greatly improve the quality of 
videoconferencing and the sharing features. 

Hosts control conference options and content, although they may also simply attend and participate 
in conferences. 

Minimum requirements: 
• Pentium 4 / 1.4 GHz  
• 256MB RAM  
• 100 MBit Network card  
• Valid TCP/IP address  
• Microsoft® Windows 2000 w/SP3, Windows XP or Windows 2003 
• Microsoft® PowerPoint® 97 and above for presentations (optional)  

Recommended: 
• Pentium 4 / 2 GHz  
• 512MB RAM  
• 100 MBit Network card  
• Video capture device for videoconferencing (USB or Firewire webcam recommended)  
• Accelerated video card 
• Valid TCP/IP address  
• Microsoft® Windows 2000 w/SP3, Windows XP or Windows 2003 
• Microsoft® PowerPoint® 97 and above for presentations (optional)  

Presenter 

Presenters attend conferences and present materials in the conference, but do not control 
conference options. 

Minimum requirements: 
• Pentium 4 / 1.4 GHz  
• 256MB RAM  
• 100 MBit Network card  
• Valid TCP/IP address  
• Microsoft® Windows 2000 w/SP3, Windows XP or Windows 2003 
• Microsoft® PowerPoint® 97 and above for presentations (optional)  

Recommended: 
• Pentium 4 / 2 GHz  
• 512MB RAM  
• 100 MBit Network card  
• Video capture device for videoconferencing (USB or Firewire webcam recommended)  
• Accelerated video card 
• Valid TCP/IP address  
• Microsoft® Windows 2000 w/SP3, Windows XP or Windows 2003 
• Microsoft® PowerPoint® 97 and above for presentations (optional)  

Participant 

Participants attend conferences but do not control the conference or its contents. 
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Minimum requirements: 
• Pentium 3 / 800 MHz  
• 128 RAM  
• 10/100 MBit Network card  
• Valid TCP/IP address  
• Microsoft® Windows 95 SR2, 98, ME, NT4 (SP3), 2000, XP or 2003 

Recommended: 
• Pentium 4 / 1.4 GHz  
• 512 RAM  
• 100 Mbit Network card  
• Video capture device for videoconferencing (USB or Firewire webcam recommended)  
• Valid TCP/IP address  
• Microsoft® Windows 2000 or XP  
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Mitel Support 
 

To contact support, please visit our web site at: http://www.Mitel.com  

or send an email to: support@Mitel.com  
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Conferencing 
Managing Conferences 

A single conferencing server can host any number of conferences as long as there are sufficient 
resources available on the server. All conferences are stored on the server and the conference 
activity is relayed from the host computer to the server and all attendees.  

Conference Properties 
• Topic: The topic of the conference is essentially its title. This is a user-defined property that is 

simply a label for the conference. 
• Password Protection: Conferences may be protected by a password. If a conference is 

password protected, anybody wishing to join the conference must enter the password in 
order to join. 

• Public vs. Private: Conferences can be either public or private. Public conferences are 
designed to be accessible to anyone who connects to the conference server, although they 
can be secured with a password if necessary. Private conferences require the attendee to 
know the conference ID or be invited in order to join the conference. 

• Conference ID: Each conference has a code that uniquely identifies the conference to the 
server. The conference ID is normally a short randomly-generated code (X70, for example), 
but it may be defined by the conference creator. The conference ID is also useful to 
attendees, as it can be used to join the conference. 
Typically, the conference ID is seen only as part of a larger URL. For example, in the join 
conference link “http://198.168.1.121/?join=A7104”, the conference ID is A7104, and the 
server is 198.168.1.121. 

Managing Conferences using Mitel Your Assistant 
The Mitel Your Assistant provides a link to the Your Assistant Collaboration Module. The options in 
the Mitel Your Assistant Collab menu allow you to create, customize, join, and remove 
conferences. You may also start a conference from the People shutter. 

Starting an Ad-Hoc Conference from the People shutter 

Mitel Your Assistant allows you to quickly create a conference with a contact listed in your People 
shutter, provided that the contact is running Mitel Your Assistant at the time.  

 
Figure 1: Starting a Conference from the People Shutter 
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To start a conference with a contact: 
• Right click on the contact and select Start Collaboration from the context menu. This option 

is available only if you are using Your Assistant and have a Your Assistant Collaboration 
Module account. 

When you select the Start Collaboration option, an invitation showing your name is sent to the 
target contact. Once the invitation is sent, the Your Assistant Collaboration Module will open and 
the conference will start with you as a Host.  

The invitee can accept or decline your invitation. If they accept your invitation, the invitee joins the 
conference. If the invitee declines, you will receive no notification.  

Conferences created using the People shutter will begin with the default conference options:  
• Video: Active, using the H.263+ codec 
• Chat: Active 
• Layout Style: Style 1, with users list shown 
• Public vs. Private: Private 
• Topic: No title 

Receiving a Conference Invitation from Mitel Your Assistant 

If you use Mitel Your Assistant, you may receive a conference invitation generated by another user. 
Conference invitations look much like an incoming call notification or a chat request: 

 
Figure 2: Conference Inviation 

The name of the inviter, who will be the Host of the conference, is shown. To join the conference, 
click Start Web Conference; the Your Assistant Collaboration Module will start and place you in 
the conference. Otherwise, click Decline. If you click Decline, the invitee will not be notified.  

Starting an Ad-Hoc Conference from the Collab Menu 

 
Figure 3: Start Web Conference Now Option 

The fastest and easiest way to start a conference through Mitel Your Assistant is to use the Start 
Web Conference Now option in the Mitel Your Assistant Collab menu. Clicking this option causes 
the Start Web Conference Now window to appear.  
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Figure 4: Start Web Conference Now Window 

1. Enter the conference topic or title into the Topic field.  

2. The Password field can be left empty if you do not need the conference to be password 
protected. Otherwise, enter a password.  

3. Check the Public Web Conference option if you want to create a public conference. If you 
leave this field blank, you will create a private conference.  

4. Click Start and Join to begin the conference.  

When you begin the conference, the Your Assistant Collaboration Module will open and the 
conference will start with you as the Host and only conference member. You may invite additional 
attendees. Conferences created using the Start Web Conference Now window will begin with the 
default conference options:  

• Video: Active, using the H.263+ codec 
• Chat: Active 
• Layout Style: Style 1, with users list shown 
• Public vs. Private: Private 
• Topic: No title. 

Setting Up or Starting a Custom Conference 

 
Figure 5: Customize Web Conference 

To set up a conference with customized options, including one that will start in the future, use the 
Customize a Web Conference option in the Mitel Your Assistant Collab menu. Clicking this option 
causes the YA Web Conference Settings window to appear.  
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Figure 6: YA Web Conference Settings Window 

• Conference Info: The conference info includes the topic, password, and whether or not the 
conference is public. 
o Enter the conference topic or title into the Topic field.  
o The Password field can be left empty if you do not need the conference to be password 

protected. Otherwise, enter a password.  
o Check the Public Web Conference option if you want to create a public conference. If 

you leave this field blank, you will create a private conference. 
• Participants’ Hyperlink: The value you enter here becomes the conference ID. The server 

uses the conference ID as a unique identifier for the conference, and attendees can use the 
ID to join the conference.  
If you leave the field blank, the server will assign a short, arbitrary ID to the conference (X70, 
for example). This ID will be displayed in conference lists and may be used to join 
conferences. 

• Start Date/Time: By default, conferences you create start immediately. However, the Start 
Date/Time option allows you to define the conference start time. Select the Start on option 
and fill in the date and time information.  

• Layout: The Layout options allow you to define the appearance of the Your Assistant 
Collaboration Module for this conference, and whether conference attendees have the right 
to alter the layout for their workstation. See The Your Assistant Collaboration Module 
Interface on page 18 to see the possible layout schemes. 
o Choose a Default layout for the conference. All attendees will start the conference in this 

layout. 
o Deselect the Show the users list option if you do not want the users list to be visible at 

conference startup. 
o Deselect the Participants may change their layouts option if you want to enforce the 

use of the default interface layout you selected above.  
• Video: The video options allow you to choose whether videoconferencing will be enabled 

automatically at the start of the conference, and what video codec will be used. Note that if 
you don’t have videoconferencing automatically enabled, it may be enabled during the 
conference if needed. 
o Deselect Show video automatically if you do not want videoconferencing to start 

automatically at the beginning of the conference. 
o Select a new video codec if the H.263+ codec does not meet your needs. 
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• Chat: The chat options allow you to choose whether chat will be enabled automatically at the 
start of the conference, and who can participate in the chat session. If you do not have chat 
automatically enabled, it may be enabled during the conference if needed. 
o Deselect Text chat with everyone if you do not want an all-attendee chat session to 

start automatically at the beginning of the conference. 
Once you have set your custom options, click Start Conference to start the conference without 
joining, or Start & Join Conference to start the conference and join it as a Host. If the conference 
is set to start at some time in the future, click the Start Conference button to commit the scheduled 
conference to the server (the Start & Join Conference button will be greyed out). The conference 
will start at the appointed time. 

Using the YA Meetings window 

The YA Meetings window, accessible through the Mitel Your Assistant main window, provides a list 
of public conferences on the Your Assistant Collaboration server. From the YA Meetings window, 
you may: 

• Join public conferences. 
• Remove conferences from the server. 
• Copy meeting URLs. 

To reach the YA Meetings window, click the Collab menu and select View Meetings. 

 
Figure 7: Your Assistant Collaboration Module, View Meetings Link 

The YA Meetings window will appear. This window shows all conferences on the server and their 
details. 

 
Figure 8: Your Assistant Collaboration Module, YA Meetings Page 

The following properties are shown: 
• Owner: The originator of this conference. The owner is also likely a conference attendee and 

Host, but this is not always the case. 
• Topic: The topic or title of the conference. 
• Meeting URL: The URL of the web conference. 
• Details: The icons in the details section provide more information about the conference. 
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o  indicates that the conference is open; mouse over the icon to see how many 
attendees are in the conference. If this icon does not appear, the conference is 
scheduled but has not yet started. 

o  indicates that the conference is public (rather than private). Since only public 
conferences are visible for most users, it is likely that all conferences listed will display 
this icon. 

o  indicates that the conference is password protected. 
o  indicates that videoconferencing is enabled. 

Copying a Conference URL 
You can copy a conference URL and enter it into your browser to join a conference and/or paste it 
into an email invitation to other participants. 

To copy a conference URL: 

Right click a conference and select Copy URL from the context menu. 

Removing a Conference 
If all conference attendees leave a conference without anyone ending it, the conference will 
continue to exist on the server despite there being no members. Dead conferences are waste of 
server resources and add clutter to the conference list. You may remove dead conferences, 
effectively ending them, if you are the conference Owner. Be sure that the conference is no longer 
needed before removing it - after all, a conference with no members could mean that the attendees 
have taken a break, or have not yet joined. 

To remove a conference: 

Right click a conference and select Remove from the context menu. 

Joining a Conference 
While you can join an open conference by entering its URL into your web browser, there is a much 
easier way to join a listed conference: 

• Double click a conference. 
OR 

• Right click a conference and select Join from the context menu. 
If you join a conference that is password protected, you will be prompted to enter the password 
when the Your Assistant Collaboration Module opens. 

Managing Conferences from the Your Assistant Collaboration Module Web Page 
The Your Assistant Collaboration Module web page is created by the Your Assistant Collaboration 
server. You do not need to be connected to the internet to access the page; you do need to be able 
to access the Your Assistant Collaboration Module server using your browser. 

The Your Assistant Collaboration Module web page provides a number of conference management 
features, including start, customize, join, and end conferences, or edit conference properties. 

Accessing the Your Assistant Collaboration Module Web Page 

The Your Assistant Collaboration Module web page can be accessed by typing in the name or IP 
address of your Your Assistant Collaboration server into your web browser. For example, in the 
graphic below, the server name “YA4“ was entered into the browser to find the web page. Using the 
server IP address of “198.168.1.121” would have produced the same result.  
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Figure 9: Your Assistant Collaboration Module Web Page 

The Your Assistant Collaboration Module web page displays all public conferences on the server 
and their details. The list of conferences is sorted by conference ID. 

Logging in to the Your Assistant Collaboration Module web page gives you additional options and 
information. To log into the web page: 

1. Enter your User Name and Password into the appropriate fields. 

2. Click Login.  

Once you have logged in, the conference list will change to display the conferences you own, which 
includes all of the existing public and private conferences you have created. 
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Figure 10: Your Assistant Collaboration Module Web Page 

You may return to the original list of all public conferences by clicking the Logout link in the top right 
corner of the page. 

Starting an Ad-Hoc Conference 

The fastest and easiest way to start a conference through the Your Assistant Collaboration Module 
web page is to use the Quick Conference box available when you are logged in.  

 
Figure 11: Quick Conference Box 

1. Enter the conference topic or title into the Topic field.  

2. The Password field can be left empty if you do not need the conference to be password 
protected. Otherwise, enter a password.  

3. Use the radio buttons to define whether the conference is public or private.  

4. Click Start Conference to begin the conference.  

When you begin the conference, the Your Assistant Collaboration Module will open and the 
conference will start with you as the Host and only conference member. You may invite additional 
attendees. Conferences created using the Quick Conference box will begin with the default 
conference options:  
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• Video: Active, using the H.263+ codec 
• Chat: Active 
• Layout Style: Style 1, with users list shown 
• Public vs. Private: Private 
• Topic: No title 

Setting Up or Starting a Custom Conference 

To set up a conference with customized options, or to set up a conference that will start in the 
future, use the Create Conference button that is available once you have logged in. 

 
Figure 12: Create New Conference Button 

Clicking the Create Conference button brings you to the Create New Conference page. From this 
page you may select custom options for your new conference.  

  
Figure 13: Create New Conference Page 

• Topic: Enter the conference topic or title into this field.  
• Password: This field can be left empty if you do not need the conference to be password 

protected. Otherwise, enter a password.  
• Starting Time: By default, conferences you create start immediately. However, the starting 

date and time options allow you to define the conference start time as some time in the future. 
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The Starting Time option has a second feature: Automatically open the scheduled 
conference X minutes before scheduled start. Enabling this feature opens the conference 
early for Hosts and Presenters only. Participants that attempt to join before the scheduled 
start time are denied. The extra time before the conference starts gives the Host or Presenter 
time to prepare shared materials. 

• Conference Hyperlink: The value you enter here becomes the conference ID. The server 
uses the conference ID as a unique identifier for the conference, and attendees can use the 
ID to join the conference.  
If you leave the field blank, the server will assign a short, arbitrary ID to the conference (X70, 
for example). This ID will be displayed in conference lists and may be used to join 
conferences. 

• Video Options: The video options allow you to choose whether videoconferencing will be 
enabled for the conference, whether it will start automatically at the beginning of the 
conference, and what video codec will be used. If you do not have videoconferencing set to 
start automatically, it may be started during the conference, provided that it is enabled. If you 
disable videoconferencing, it will not be available at any time during the conference. See 
Videoconferencing on page 43 for more information. 

• Enable Sharing: You can choose to disable sharing. If you disable sharing, the Share menu 
will not be available and the conference will not be able to include any shared documents, 
PowerPoint presentations, applications, desktop space, whiteboards, or annotations (see 
Sharing on page 22 for more information on these features).  

• Chat Options: The chat options allow you to choose whether a universal chat will be enabled 
automatically at the start of the conference, or if you want a private chat session with select 
users. You may select both options; multiple chat sessions can be run at the same time. If 
you don’t have chat automatically start at the beginning of the conference, chat sessions may 
be started during the conference, provided that sharing is enabled. See Chat on page 41 for 
more information. 

• Public or Private: By default, the new conference will be private. If you make it a public 
conference, it will be visible to all users in the conference lists on the Your Assistant 
Collaboration Module web page and YA Meetings window. 

• Layout Options: The Layout options allow you to define the appearance of the Your 
Assistant Collaboration Module for this conference, and whether conference attendees have 
the right to alter the layout for their workstation. See The Your Assistant Collaboration 
Module Interface on page 18 to see what the layout schemes look like. 
Deselect the Allow participants to change their layout option if you want to enforce the 
use of the default interface layout you select.   

• Users List: You may define whether or not the users list is visible to conference attendees 
with Presenter or Participant status. See User Status and Privileges on page 20 for more 
information on what is meant by Presenter or Participant status, and The Users List on page 
20 for more information regarding the users list. 

Once you have set your custom options, click Start to start the conference without joining, or Start 
and Join to start the conference and join it as a Host. If the conference is set to start at some time 
in the future, click the Start button to commit the scheduled conference to the server (clicking the 
Start and Join button will also schedule the conference, but you will not be able to join the 
conference if it has not started yet!). The conference will start at the appointed time. 

Joining a Conference 

You may join any conference listed on the web page: 

1. Click on the link associated with the conference to join the conference. The Your Assistant 
Collaboration Module will start. 
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2. If the conference is password protected, you will be prompted to enter the password when 
Your Assistant Collaboration Module starts. 

If you are not logged in, the Join Conference box is shown at the bottom left of the web page. You 
may join any conference (public or private) using this feature. 

1. Enter the conference number (e.g.: A7104) into the Join Conference box, and click the Join 
button. The Your Assistant Collaboration Module will start. 

 
Figure 14: Join Conference Box 

2. If the conference is password protected, you will be prompted to enter the password when 
Your Assistant Collaboration Module starts. 

Joining a Conference using the Browser Address Bar 
If you know the name or IP of your Your Assistant Collaboration Module server and the conference 
ID of the conference you wish to join, you may join the conference from your web browser without 
going to the Your Assistant Collaboration Module web page or opening the Mitel Your Assistant. 
Type the following string into your web browser address bar: 

http://<server name or IP address>/?join=<conference ID> 

For example, if your server name was YA4 and its IP was 198.168.1.121 and the conference ID 
was A7104, you could use either of the following strings: 

http://198.168.1.121/?join=A7104 

http://YA4/?join=A7104 

Viewing and Editing Conference Details 

You may view and change the details of the conferences you created. To access the conference 
details, log into the web page and click the Details link at the right side of the conference list. 

 
Figure 15: Conference Details Link 

The conference details screen shows the conference topic, whether the conference is public or 
private, if it is possible to join the conference, and how many attendees it has. By clicking the Set 
Password link, you may also see the current password for the conference, if it has one. 

 
Figure 16: Conference Details Screen 
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From this screen you may set the conference password, make the conference public or private, 
open or close conference entry, and end the conference. 

Viewing or Changing the Conference Password 
To view or change the conference password: 

1. Click the Set Password link on the left side of the page. 

2. The Password field will appear. If the field is already filled, this means that the conference is 
password protected and the contents of the field is the password. If the field is empty, the 
conference is not password protected. 

 
Figure 17: Password Field 

3. Enter a password into the field, or change the existing password if needed. Alternately, leave 
the field blank or erase the existing password if you do not want the conference to be 
password protected. Click Save Password to commit your changes.  

Changing the Public / Private Status of a Conference 
You may change the public/private status of any conference you create. Click the Make Private 
button to make the conference private, or the Make Public button to make the conference public. 

Opening and Closing Entry 
You may open or close entry to any conference you created, permitting or denying new attendees 
to join. Click the Open Entry button to permit new attendees, or the Close Entry button to deny 
new attendees. Typically, conferences are open unless they are scheduled to start at a later date. 

Ending the Conference 
If all conference attendees leave a conference without anyone ending it, the conference will 
continue to exist on the server despite there being no members. Dead conferences are waste of 
server resources and add clutter to the conference lists. You may end dead conferences from the 
web site if you are the conference creator. Be sure that the conference is no longer needed before 
removing it - after all, a conference with no members could mean that the attendees have taken a 
break, or have not yet joined. 

Click the End Conference button to end the conference. 

Generating Conference Invitation Emails 
You may extend an invitation to potential conference attendees using emails automatically 
generated by Your Assistant Collaboration Module. To do so, you must join the conference 
yourself, which brings up the Your Assistant Collaboration Module interface. 

1. Join the conference as a Host, or join and then obtain Host user status (see User Status and 
Privileges on page 20 for more information). You may join any conference you created as a 
Host by joining it from the YA Meetings list or logging into the Your Assistant Collaboration 
Module web page and then joining it from the conference list. 

2. Click the Conference menu and select Invite. 

OR 

Click the Invite button ( ) at the upper right corner of the interface.  

Your default email application will open and automatically generate an invitation email.  
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Figure 18: Your Assistant Collaboration Module, Sample Conference Invite 

3. Modify the email, if required, and add one or more addressees. If the conference is password 
protected, you might want to include the password in the invitation. Send the email as normal. 

Changing your default email client 
If, after clicking the Invite button, you find that the email application that opens is not the one you 
wish to use, you can change your computer’s default email application through Internet Options: 

1. Log on as Administrator. 

2. Open Internet Explorer, click the Tools menu, select Internet Options. Click the Programs tab 
and select your email client from the drop-down list. Click the OK button. 

Receiving Conference Invitation Emails 
Conference invitation emails are received just like other email. Click on the link in the invitation to 
open Your Assistant Collaboration Module and join the conference. Even if you receive an 
invitation, you still need to enter the correct password to join a password-protected conference. 
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The Your Assistant Collaboration Module Interface 
The default conference interface is divided into four major areas: the videoconferencing pane, the 
chat pane, the users list, and the shared objects pane.  

Layout Style 1 (default layou   

 

1. Videoconferencing pane: The 

. 
 

ature. 
tive 

er 

e information on the chat feature. 

st, Presenter, or Participant). 
cts 

nd 
 not 

details on sharing objects.  

videoconferencing pane contains live video 
from one or more of the conference attendees
See Video on page 43 for more information on
the videoconferencing fe

2. Chat pane: The chat pane contains any ac
chat sessions between you and the oth
conference attendees. See Chat on page 41 
for mor

3. Users list: The users list shows all conference 
attendees and each attendee’s user status 
(Ho

4. Shared objects pane: The shared obje
pane displays shared documents a
PowerPoint presentations. This pane may
be disabled. See Sharing on page 22 for more 

Layout Style 2 Layout Style 3 Webinar Layout 
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Figure 19: Your Assistant Collaboration Module Layout Styles 
Customizing your Interface 

You may customize your interface so that some panes do not appear, and you may resize them as 
required. Panes may be resized by clicking and dragging the pane dividers ( ). You may 
also hide panes using the dividers; double click the divider associated with the pane (the arrow on 
the divider points to its associated pane or panes) to hide the pane. Double click the divider again to 
redisplay the hidden pane or panes. 

The chat and videoconferencing panes close automatically if there are no active chat or video 
streams, respectively. To display these panes once they are closed, start a new chat session or 
enable a video stream. 

Choosing your layout 
If you have sufficient permissions, you may change your interface layout. 

1. Click the Layout menu. 

2. Choose one of the following options:  
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Figure 20: Layout Menu 

o Style 1: This is the default l rences. See the images above for 

nd shared objects 

or 

ayout style for ad-hoc confe
out. an example of this lay

o Style 2: See the images above for an example of this layout. 
: See the images abo Style 3 ove for an example of this layout.  

 o Webinar: The webinar format shows only the videoconferencing a
panes. See the images above for an example of this layout. 

o Share Only: Only the shared objects pane is displayed. This layout is useful for large 
detailed shared objects. 

o Video Only: Only the videoconferencing pane is displayed. Note that video streams 
have a maximum size defined by the video resolution used, so Video Only mode will not 
necessarily give you a much larger video image. 

o Full Screen: Much like Share Only, except that the shared objects pane takes up the 
entire screen. Click the Cancel Full Screen button (or press F11) to revert back to your 
last layout. 

 
Figure 21: Cancel Full Screen Button 

Defining Interface Appea

rivileges on page 20 for more details), you may 

ur layout to all attendees: 

rance for all Attendees 

If you have Host user status (see User Status and P
force the layout you are using on all conference attendees. This is can be useful for Hosts who want 
to take advantage of the layout features to emphasize certain facets of their presentation, such as 
video or document/application sharing. 

There are a number of ways to apply yo
• Click the Conference menu and select Apply My Layout. 

 
Figure 22: Apply My Layout Option 

OR 
• the Apply My Layout keyboard shortcut (default Ctrl + F10). Use 

OR 
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•  have a shared document or presentation, click the Apply My Layout button on the If you
sharing toolbar. 

 
Figure 23: Sharing Toolbar 

Follow My Layout 
out feature is essentially a continuous Apply My Layout command; with Follow 

ature: 
lect Follow My Layout. 

ference:  

ter 

ghest rights in a conference and is typically the conference moderator. 

 

ees who are promoted and given the right to use the sharing features in a 

rence. 

 are able to control the navigation of shared objects, create 
pants 

The Users List 
vides a list of all conference attendees, sorted by status. An attendee with Host 

The Follow My Lay
My Layout active, Your Assistant Collaboration Module applies your layout to other users every 
time you make a layout change.  

To toggle the Follow My Layout fe
• Click the Conference menu and se

User 
There are three types of users in a con

Status and Privileges 

• Host 
• Presen
• Participant 

The Host has the hi
Typically, only one conference attendee has Host status, but one Host may promote other 
attendees to Host status. Hosts have access to all conference features and may control the
conference entirely.  

Presenters are attend
conference, allowing them to lead a presentation during the conference.  

Participants are attendees who are considered the audience and view activities in a confe
They can be invited to chat sessions and may be able to change personal options such as their 
workstation’s interface layout.  

Hosts have all privileges -- they
annotations, change their layout, and look ahead in the presentation. Presenters and Partici
have fewer privileges. Users with Host status may grant or remove privileges from other attendees 
as required. 

The Users List pro
status can use the users list to change attendees’ status and grant privileges. Typically, the list 
appears at the bottom left corner of the interface, although it may appear somewhere else or not at 
all, depending on the conference options and layout. 
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Figure 24: Users List 

The users list is also used to control videoconferencing. See Videoconferencing on page 43 for 
more information. 

Changing User Status 

Only attendees with Host status can change the status of other attendees in a conference. To 
change the status of an attendee:  

1. Right-click the user. 

2. Select one of the Make options.  

The options include: 
• Make Participant: All attendees who join a conference are automatically assigned 

Participant status. Participants can only view the activities in a conference unless a Host 
grants the Participant additional privileges (see below). 

• Make Presenter: Participants can be promoted to Presenters. Once promoted, a Presenter 
can share documents by using the sharing features. 

• Make Host: This option makes an attendee a Host, which allows the attendee to change user 
status and grant privileges. 

• Make >: The Make submenu provides options to change the user status as well as grant all 
privileges (see below). Using this submenu is simply a shortcut -- otherwise, you will need to 
change the user status and then grant privileges individually. 

Granting Privileges 

By default, only a Host or Presenter may navigate documents, control the presentation, add 
annotations, and change their layout. However, a Host may grant other conference attendees 
these privileges. A Host can elevate the privileges of an attendee by using the following method:  

1. Right-click the user. 

2. Select Privileges from the context menu. 

3. Select the appropriate privileges.  
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Options include: 
• Give/Remove Control: This option gives the attendee rights to control a shared document or 

presentation and the ability to use the Apply My Layout and Follow My Layout features. When 
this option is enabled for an attendee, an arrow will appear within the attendee’s icon ( ) to 
indicate they can control the presentation. This option is best used when the Host wants 
another attendee to control the shared document. 

• Give/Remove Look Ahead: This option allows the selected attendee the ability to move 
between slides or pages without affecting other attendee in the conference. Note that 
attendee with control rights still have overall control over shared PowerPoint presentation 
and document navigation. 

• Give/Remove Annotate: This option allows the selected attendee to create annotations. 
The Annotate button will become visible for that attendee. See Annotations on page 36 for 
more details. 

• Give/Remove Change Layout: Allows the attendee to change their layout using the Layout 
menu. Without this privilege, attendees must view the conference in the layout selected by 
the Host. All attendees have this privilege by default unless the custom conference options 
specifically removed it.  

Attendee Flow  
Unless the conference is closed to new entrees (see Opening and Closing Entry on page 16), 
attendees may join or leave the conference as they please. Even the owner may leave the 
conference without ending it; conferences do not end unless specifically instructed to. Whenever 
an attendee joins or leaves the conference, all other attendees are notified with a popup and alert 
noise. These notifications may be customized or disabled; see Notification Options on page 63 for 
more information. 

  
Figure 25: Conference Notifications 

You can leave a conference at any time by clicking the close button ( ) in the top right corner of 
the Your Assistant Collaboration Module, or by selecting Leave Conference from the File menu. 
See Leaving and Ending Conferences on page 54 for more information. 

Sharing 
Sharing allows the Host or Presenter to add a document, PowerPoint presentation, application, 
desktop, or blank whiteboard to a conference. Shared objects are visible to all conference 
attendees. Depending on what is being shared, shared objects may be browsed, modified, 
navigated, and annotated during the conference. 

All share features are accessible from the Share menu at the top of the application. 
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Figure 26: Your Assistant Collaboration Module Share Menu 

How Sharing Works 

Shared documents, applications, presentations, browsers, and regions are not actually reproduced 
on the computers of the conference attendees. Rather, the shared area is sent to the Mitel Printer 
and converted into a vector graphic which is displayed to the other attendees.  

This arrangement has its advantages. When sharing an application, only the Host or Presenter 
needs to have the application installed because the conference attendees will be viewing a picture 
of the application rather than opening the application themselves. Furthermore, even attendees 
with a slow connection to the server will be able to keep up with those with fast connections 
because all attendees are navigating a vector image on their local computers instead of a 
document on a server. 

Bandwidth Requirements 
Shared document and presentation files are generally 500 KB to 4 MB per presentation. Using the 
Mitel Printer, the entire file is sent to the server by the sharer, and then from the server to other 
attendees. Thereafter, only slide change commands are relayed via the server. Document and 
presentation sharing can be done on dial-up connections (56kbps or less). For sizing purposes, use 
8 kbps for transmission and receiving (average PowerPoint presentation size divided into 1 hour). 
Key note, after initial PPT transmit, traffic is very low. 

Remote control, desktop and region sharing, application sharing, and browser sharing use up to 
300 kbps for transmission and receiving while under load (user activity). Traffic is much less 
"lumpy" than document or presentation sharing, but there are long periods of no activity and no 
traffic. 

If you wish to know more about your bandwidth requirements during a conference, you can track 
your bandwidth use using the Your Assistant Collaboration Module bandwidth monitor. See 
Appendix B: The Bandwidth Monitor on page 64.   

Sharing Multiple Objects 

One of the big advantages of the Your Assistant Collaboration Module is that you can share 
multiple objects simultaneously. There is no special procedure for sharing multiple objects: once 
one object is shared, you may share additional objects using the same procedure. 

Shared regions, applications, and web browsers appear in their own windows, which may be 
individually closed. Shared whiteboards, documents, and PowerPoint presentations appear in the 
Your Assistant Collaboration Module; when you have more than one of these objects, you may 
switch between them using the tabs at the bottom of the application. Sharing a desktop also creates 
a tab, but the tab merely provides access to a Stop Sharing button. 

 
Figure 27: Shared Document Tabs 
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Graphics and Frame Rate Optimization 

Depending on what you are sharing, your computer may experience slowdowns while sharing 
objects. Slowdowns become more likely as the area you share becomes larger (such as the entire 
desktop). To improve the performance of the sharing features, you can optimize the sharing 
parameters. 

1. Click on the File menu and select Options. 

2. In the Options window, select the Sharing tab.  

 
Figure 28: Your Assistant Collaboration Module Sharing Tab 

The sharing options allow you to define the quality of the vector graphics shared with the other 
users. Choosing higher quality graphics makes the shared areas look better, but sacrifices the 
frame rate of the presentation and may lead to slowdowns. Alternately, for sharing your desktop or 
applications, you may define the frame rate. A higher frame rate is better for demonstrating tasks 
and actions, but sacrifices quality of graphics. If insufficient system resources or bandwidth prevent 
the Your Assistant Collaboration Module from meeting the quality and frame rate settings you 
choose, the Your Assistant Collaboration Module will first sacrifice frame rate, then image quality, 
until the available resources can meet the reduced demands. 

You may set the sharing options for documents and PowerPoint presentations separately from 
other shared objects using the radio buttons in the upper portion of the window. 

Use CAPTUREBLT 
The Use CAPTUREBLT setting defines whether or not windows overlapping the shared region or 
application are included in the shared image. By default, they are not; what is shared is confined to 
the contents of the shared region, not what is layered on top of it. Select the Use CAPTUREBLT 
option to include objects layered on top of the shared region in your presentation. 

Note that CAPTUREBLT is not supported by all video cards. 

Sharing and Video Streams 

Depending on what you are sharing, the Your Assistant Collaboration Module may need to free 
system resources to initiate the sharing process in a timely manner. Any video streams running 
when you begin sharing an object may be paused so that the Your Assistant Collaboration Module 
may devote more system resources to sharing. If this occurs, you will be notified by a “Paused 
(while sending)” message overlaid on the paused video streams. The pause is temporary; the video 
streams will come available again once the other attendees receive the shared object. 
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The Mitel Printer 
The Mitel Printer is what Your Assistant Collaboration Module uses to “print” a shared document or 
presentation to the conference -- it is what enables you to share the document or presentation 
without sharing the application. The Mitel Printer can also be used to print directly from the 
document’s source application into the conferencing session; essentially, it can be used to access 
the Share Document or Share PowerPoint Presentation features from outside the Your Assistant 
Collaboration Module. This feature is ideal if you work in an application, like an accounting program 
for example, and only need to share a printed report with attendees in the conference.  

Note that the Mitel Printer does not print anything to a real printer; it “prints” to a conference. The 
Mitel Printer installs automatically the first time you use the Share Document feature in Your 
Assistant Collaboration Module. 

Installing the Mitel Printer 

The Mitel Printer is installed automatically the first time you share a document through the Your 
Assistant Collaboration Module. However, you may install it earlier if you wish to print documents 
directly to the Mitel Printer without going through the Your Assistant Collaboration Module interface.  
Regardless of the method used to install the Mitel Printer, you must have administrative access to 
the workstation in order to install it.   

1. Click the File menu and select Options. 

2. Select the General tab. 

3. Select the Share printed documents automatically option. 

Using the Mitel Printer 

While the Mitel Printer is used automatically whenever you share a document using the Share 
menu, you may wish to print the document directly to the Mitel Printer from its native application. 
This is useful for sharing documents from an application that is already open, or sharing the 
document without saving it and without sharing the application. Accessing the Mitel Printer in this 
fashion has the same effect as using the Share menu.   

To print a document or presentation directly to the Mitel Printer: 

1. Switch to the desired application, and open the document or presentation if it is not already 
open. 

2. Select File from the menu bar. 

3. Select Print. 

4. Select the Mitel Printer from the printer dialog. Do not click the printer icon on the application 
toolbar because the default printer may not be the Mitel Printer. 

5. Switch back to the web conferencing client to view the printed output. 

Sharing a Document 
The Share document feature is used by the Host or Presenter to share a document with other 
attendees in the conference. Shared documents may be navigated and annotated, but they may 
not be modified; shared documents are shared as read-only images through the use of the Mitel 
Printer. Therefore, this feature is best used when an attendee wants to share a document that is 
already complete and requires no changes. If you want to collaborate on a document, you must 
share the application (like Word or Excel for example). Use the Share Application feature in this 
case. Shared documents appear in the Shared Objects pane. 
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Before you share a document you must ensure the application that created the document is 
installed on your computer. The Mitel Printer is also required for sharing documents, but it installs 
itself automatically upon sharing your first document (see The Mitel Printer, above, for more 
information). Participants viewing the presentation do not need to have the application installed on 
their computer, nor do they require the Mitel Printer.  

Using the Share Document Feature 

To share a document: 

1. Click the Share menu and select Document. 

2. A file browser will appear. Use it to select the document you want to share. 

3. After selecting the document, the application that created the document will start and will 
automatically print the selected document to the Mitel Printer. The output from the Mitel 
Printer is uploaded to the conference. 

The shared document is displayed in the shared objects pane; no new window is opened. 

The Share Document feature is designed to work with almost all Windows-based applications. 
However, if you encounter issues when sharing a document, consider printing the document from 
the application directly to the Mitel Printer using the application’s Print feature. The printed output 
will be sent directly to the conference and not to an actual printer. 

To stop sharing a shared document, click the Stop Sharing button located at the upper right corner 
of the application ( ),or use the stop sharing keyboard shortcut (default: Ctrl + Shift + S). 

Navigating a Shared Document 

Only users with control or look ahead privileges can navigate a shared document; see Granting 
Privileges on page 21 for more details on granting privileges. Navigation is performed with the 
navigation controls that appear in the shared objects pane. 

 
Figure 29: Navigation Controls 

Sharing a Powerpoint Presentation 
The Share PowerPoint Presentation feature allows a Host or Presenter to select any PowerPoint 
document and present it to attendees in a conference. To use this feature, the Host must have 
PowerPoint installed and have access to the PowerPoint document. Participants viewing the 
presentation do not need to have PowerPoint installed on their computer. Shared presentations 
appear in the Shared Objects pane. 

Note: All animations within the PowerPoint document are converted to transition steps after the 
document is shared. 

Using the Share PowerPoint Presentation Feature 

To share a PowerPoint document: 

1. Click the Share menu and select PowerPoint Presentation. 

2. A file browser will appear. Use it to select the presentation you want to share. 

The shared presentation is displayed in the shared object pane; no new window is opened. 
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To stop sharing a PowerPoint presentation, click the Stop Sharing button located at the upper right 
corner of the application ( ),or use the stop sharing keyboard shortcut (default: Ctrl + 
Shift + S). 

Navigating a Shared Powerpoint Presentation 

Only attendees with control or look ahead privileges can navigate a shared PowerPoint 
presentation; see Granting Privileges on page 21 for more details on granting privileges. Navigation 
is performed with the navigation controls that appear in the shared objects pane. 

 
Figure 30: Navigation Controls 

Sharing a Region 
The Share Region feature is designed to allow the Presenter to display a section of the desktop to 
other attendees in the conference. This tool is an alternative to the desktop sharing tool, which 
shares the entire desktop. 

Using The Share Region Feature 

To enable the region share: 

1. Click the Share menu and select Region. 

2. A green-bordered Region window will appear. Everything within the boundaries of the 
window is visible to the other conference attendees. Click and drag the title bar to move the 
window so that it covers the area of the desktop you wish to share.  

 
Figure 31: Your Assistant Collaboration Module, Shared Sample Region 

The Region window is “transparent” (it is only a window boundary with no contents), and it remains 
on top of all other windows and applications. You may resize the Region window as required by 
clicking and dragging the corners of the window. The resize action is dynamic, so it can be done 
while attendees are actively viewing the shared region. You may also minimize or maximize the 
Region window if required; click the minimize button ( ) to hide the window, or the maximize button 
( ) to share the entire desktop. 

To stop sharing the region, close it by clicking the close button ( ), click on the Stop Sharing 
button in the top right corner of the Region window ( ), or use the stop sharing 
keyboard shortcut (default: Ctrl + Shift + S). 
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Sharing an Application 
The share application feature is used by the Host or Presenter to share almost any application that 
has a user interface. When active, the Share Application feature places a border around the 
application and will share everything within the border. This feature is ideal for a variety of purposes 
including training and online technical support. 

Using The Share Application Feature 

To use the share application feature 

1. Click on the Share menu and select Application. 

2. The Share Application window will appear so you can select the application. Use the radio 
buttons at the top of the window to define the list of applications to choose from. 

 
Figure 32: Share Application Window 

3. Select an application from the list and click Start Sharing. 

4. If the shared application is already running, the current instance will be shared. If you have 
chosen an application that is not running, the application will start up and then be shared. 
Once the application is available, the Your Assistant Collaboration Module will place a green 
window border around the shared application to indicate that it is shared.  

Shared applications will appear as normal except that a Stop Sharing button is added to the upper 
right corner. The application (and its window border) may be moved and resized normally by 
dragging the title bar or borders of the application. Attempting to move or resize the green border 
directly has no effect. Move and resize the application, and the green border will adjust accordingly. 
You may minimize and maximize the application as normal. 

Note: The Share Application feature will share child windows only if the child window is within the 
area of the application.  

Close the application to stop sharing it. If you wish to stop sharing the application but leave it open, 
click the Stop Sharing button at the top right of the application, or use the stop sharing keyboard 
shortcut (default: Ctrl + Shift + S). The application will minimize, but will not close (although it will 
no longer be shared). 
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Figure 33: Stop Sharing Button 

Sharing a Web Browser 
Sharing a web browser on the Host or Presenter's computer is a convenient way to display 
websites to attendees. Once enabled, the browser is launched and the entire region inside the 
browser window is displayed to all attendees in the conference. The mouse movements are 
synchronized in the view. 

Using the Share Web Browser Feature 

To use the Share Web Browser feature:  

1. Click on the Share menu and select Web Browser. 

2. Your Assistant Collaboration Module will open an instance of your default web browser, and 
place a green border around it to indicate it is shared. All browser contents within the green 
border are visible to other conference attendees. Use this browser as you would normally. 

Note: You can share pop-up windows if the pop-up window is placed over the shared browser area. 

A shared browser will appear as normal except that a Stop Sharing button ( ) is added 
to the upper right corner. The application (and its border) may be moved and resized as normal by 
dragging the title bar or borders of the browser. Attempting to move or resize the green border 
directly has no effect; move and resize the browser, and the green border will adjust accordingly. 
You may minimize and maximize the browser as normal. 

You may stop sharing the browser simply by closing it. To stop sharing the browser without closing 
it, click on the Stop Sharing button in the top right corner of the browser ( ), or use the 
stop sharing keyboard shortcut (default: Ctrl + Shift + S). 

Sharing a Desktop 
The desktop sharing feature allows the Host or Presenter to share their desktop with all attendees 
in the conference. This is much like the Share Region feature, except that the region is the entire 
desktop. 

Using The Share Desktop Feature 

To share the desktop: 
• Click on the Share menu and select Desktop. You will receive a popup informing you that 

your desktop is being shared, and the Your Assistant Collaboration Module will minimize. 

 
Figure 34: Shared Desktop Popup 

You may redisplay the Your Assistant Collaboration Module at any time, but the Your Assistant 
Collaboration Module will attempt to display the shared image in the Shared Objects pane. This 
causes an odd recursive sharing effect reminiscent of two mirrors reflecting each other; it looks 
unusual, but it will not harm the application or the conference. 
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To stop sharing your desktop, either use the stop sharing keyboard shortcut (default: Ctrl + Shift + 
S), or redisplay the Your Assistant Collaboration Module and click the Stop Sharing button at the 
top right corner of the Shared Objects pane. 

Optimize the view of the shared desktop 

The Collaboration Module displays the shared desktop in its actual size by default. This view size 
may not be appropriate for attendees who have their screen resolution set lower than the person 
sharing their desktop.  

To optimize the view of the shared desktop, attendees viewing the desktop can alter the view on 
their own computers by clicking the Fit View option on the toolbar. After selecting the Fit View 
option, the desktop view can be adjusted so the desktop image is displayed to the attendee’s 
preferences. The adjustment is made by moving the splitter bar to the left or right. 

Sharing a Whiteboard 
The Whiteboard feature is a scratch pad / drawing canvas for the conference session. When used 
in conjunction with the annotation features, the whiteboard feature can be an effective collaboration 
tool. 

Using the Share Whiteboard Feature 

To use the Whiteboard feature:  
• Click on the Share menu and select Whiteboard. 

A blank, white canvas and the annotation toolbar will appear in the Shared Objects pane. The 
canvas is visible to all attendees. The annotation toolbar contains drawing tools that allow you to 
create drawings and diagrams on the canvas; see How To Use The Annotation Tools on page 36 
for more details.  

To stop sharing the whiteboard, click on the Stop Sharing button in the top right corner of the 
browser ( ), or use the stop sharing keyboard shortcut (default: Ctrl + Shift + S). 

Remote Control 
The Remote Control feature allows you to control another attendee’s shared desktop, or 
alternately, it allows another user to control your desktop. In this fashion, you may open, present, 
and edit files that reside on another attendee’s workstation.  

Remote control must be requested, so attendees cannot simply take over another’s workstation 
without their permission. 

Requesting and Using Remote Control 

A Host may request remote control, which is the ability to control the desktop shared by another 
attendee. This allows the controlling attendee to run the presentation or demonstrate something 
using another attendee’s desktop, applications, and files.  

Requesting Remote Control 
Only an attendee with Host rights can request remote control. Naturally, you cannot request remote 
control of yourself. 

1. To initiate a remote control request, do one of the following: 
o Select the user in the users list and click the Remote Control button ( ). 
o Right-click a user in the users list and select Remote Control from the context menu. 

From the submenu, select Request Remote Control.  
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2. A request for remote control is sent to the attendee. They may accept or decline. In addition, 
if the potential controllee is of Participant status, requesting remote control automatically 
promotes them to Presenter status. The promotion occurs because being controlled means 
that you must share your desktop, and the Participant status does not grant the right to use 
the sharing features. 

3. If the attendee accepts the request, you receive control of their shared desktop. If the 
attendee was not sharing their desktop when they accepted, the Your Assistant 
Collaboration Module begins to share their desktop now. 

Operating Remote Control 
How remote control appears and operates depends on whether you are the controller or the 
controllee. In either case, remote control does not give the controlling user exclusive control of the 
controlled workstation; the controllee can still use their keyboard and mouse normally. However, 
the controlling user has the same level of control using their keyboard and mouse. If both the 
controller and controllee provide input simultaneously, the controlled workstation will attempt to 
satisfy both inputs at the same time, resulting in confusion.  

• As the Controller: When you receive remote control of another attendee’s desktop, the Your 
Assistant Collaboration Module shows the shared desktop in a window over the shared 
objects pane, as normal. However, when you mouse over the shared desktop, you are given 
control of it; clicking icons will open files and applications, typing will edit text, etc.  

 
Figure 35: Shared Desktop 

• As the Controllee: When another user takes control of your desktop, the Collaboration 
Module will automatically minimize in order that what is being shared is not simply another 
copy of the Collaboration Module. The name of the controller will be visible in the top right 
corner of the screen. 
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Ending Remote Control 

Regardless whether you are the controller or the controlled party, you can stop the stop the remote 
control session using the following method:  

• Use the stop remote control keyboard shortcut (default: Ctrl + Shift + R). 
Alternately, if you stop sharing the desktop, the remote control is also broken: 

1. Maximize the Your Assistant Collaboration Module. Note that if you are the controlling party, 
this means you must maximize the controlled attendee’s Collaboration Module (as your own 
will already be maximized). 

2. Click the Stop Sharing button on the tool bar to stop sharing your desktop. This will stop 
sharing the controlled desktop and end remote control. 

Receiving a Remote Control Request 

Any time during a conference, you may receive a Remote Control popup request from another 
attendee.  

 
Figure 36: Your Assistant Collaboration Module, Remote Control Request 

Click Yes to relinquish control of your shared desktop, or No if you wish to retain control. 

Giving Remote Control to Another Attendee 

If you wish to provide another attendee the ability to control or present materials on your desktop, 
you may give them remote control. This is useful if the user cannot request remote control 
themselves because they are not a Host.  

You must have Host status in order to give another attendee remote control. 

1. Share your desktop as normal (see Sharing a Desktop on page 29 for the procedure). 

2. Right-click the attendee you wish to submit control to in the users list and select Remote 
Control from the context menu.  

3. From the submenu, select Give Remote Control. 

The selected attendee will be granted remote control of your desktop. Remote control granted in 
this manner is ended in the usual manner (see Ending Remote Control, above). 

Working with Shared Objects 
Once an object is shared, the Host or Presenter may navigate, annotate, highlight, and otherwise 
control the presentation using tools provided by the Your Assistant Collaboration Module. Other 
attendees can change how they view the shared object, but, unless they have been given specific 
privileges, their part in the presentation of the shared object is simply that of the passive audience. 
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How Shared Objects Appear and How to View Them 
Shared objects – documents, Power Point presentations, browsers, applications, desktops, and 
whiteboards – appear differently for the conference attendee sharing the object (the sharer) and the 
audience (the sharees). 

For the Sharer 
For the sharer, shared documents, Power Point presentations, and whiteboards appear in the 
Shared Objects pane. Shared applications and browsers appear as normal in separate windows, 
although they have a green border to indicate that they are shared. Shared regions appear as a 
green window border with no contents. Shared desktops have no appearance; apart from a 
transient popup noting that your desktop is shared and the addition of a Stop Sharing button to the 
Shared Objects pane, the Your Assistant Collaboration Module and your other applications do not 
change. 

If you are sharing multiple objects, you may be able to see several simultaneously. Shared regions 
are visible unless minimized and shared desktops are always visible. Shared applications and 
browsers appear in their own windows, and are visible as long as they are not minimized or 
obscured by other windows. Only one shared object is visible in the Shared Objects pane at a time, 
so only one shared document, presentation, or whiteboard may be visible. If you have multiple 
shared documents, presentations, or whiteboards, use the tabs at the bottom of the Shared Objects 
pane to select which one you wish to view. Shared desktops also create a tab, but this is only to 
provide access to a Stop Sharing button. 

If you are sharing a document, presentation, or whiteboard at the same time other attendees are 
sharing objects, you must use the tabs at the bottom of the Shared Objects pane to select which 
object you wish to view. To avoid confusion over what each tab refers to, the name of the sharer 
appears beside each object name in the tabs. 

 
Figure 37: Shared Objects Tabs 

For the Sharee 
Unless you are the attendee sharing the object, all shared objects appear in the Shared Object 
pane. Only one shared object is visible at a time; if there are multiple shared objects in the 
conference, use the tabs at the bottom of the Shared Objects pane to select the object you wish to 
view. 
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Figure 38: Shared Object Pane 

Shared objects that are minimized or defocused by the sharer are not visible to the other attendees. 
For the audience, the Shared Objects pane will go grey and display a message noting that the 
shared object is not available for the time being. 

  
Figure 39: Sharing Message 

Shared Objects Toolbar 
Shared documents and PowerPoint presentations have a number of navigation and display 
controls provided by the Your Assistant Collaboration Module. All controls are accessible from the 
toolbar at the top of the Shared Objects pane, although which controls are visible depends on your 
user status and privileges. 

 
Figure 40: Shared Objects Controls 

• Navigation Controls: The Host and select attendees can navigate a shared document with 
multiple pages by using the navigation controls on the toolbar. 
This control is only available to a Participant if the Host has granted them Look Ahead or 
Control rights.  

  
Figure 41: Navigation Controls 

• Zoom: Users can enlarge sections of the document by using the zoom tool. Click the Zoom 
button ( ) and click on the document to zoom in. To zoom out or fit the document to the 
page, select the drop down menu to the right of the zoom icon and select an option. 

• Full Screen: The Host or Presenter has the option to display shared objects in full screen 
mode. To enable full screen mode, click the Full Screen button on the toolbar. 
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Tip: If you have Host or Presenter status, this display mode can be applied to all attendees in 
the conference by using the Apply My Layout option located under the Conference menu, or 
using the keyboard shortcut (default: Ctrl + F10).  

• Pointer and Arrow tools: The Pointer ( ) and Arrow ( ) tools are your cursor options. The 
pointer option is useful as it can be seen by other attendees; see The Pointer Tool, below, for 
more information. 
The pointer tool is available only to attendees with Host or Presenter status.  

• Annotate: The Annotation tool allows you to add annotations to the shared document or 
presentation. Clicking the Annotate button reveals the Annotation toolbar; see Annotations 
on page 36 for more information. 
The annotation tool is only available to attendees with Annotation rights.  

• Apply My Layout: This control allows you to force all other attendees to use your current 
interface layout: the position and size of your panes and windows. The effect is 
instantaneous – all other conference attendees will have their layout changed to match yours 
when you click the Apply My Layout button. Nothing, however, prevents them from 
changing it back to their preferred layout. 

Only the attendees with control privileges (noted by the  icon in the users list) can use this 
control. 

• Auto Scroll: This is a useful feature that automatically scrolls around a shared document or 
presentation if you move the pointer tool (see below) to the edge of the visible area of the 
document. In this manner, Auto Scroll allows you to scroll through the document without 
using the scroll bars. Auto Scroll also automatically scrolls through a shared document 
controlled by another attendee. If they are using the pointer tool on an area of the document 
that is outside of your view, your Shared Objects pane will scroll to that location. 
Auto scroll is enabled by default, but all attendees have the option of disabling it by clicking 
the Auto Scroll button. 

• Fit In View: Clicking the Fit in View button zooms the object in the Shared Objects pane so 
that one page or slide is entirely visible. 
All attendees have access to the Fit In View button. 

• Fit To Width: Clicking the Fit To Width button zooms the object in the Shared Objects pane 
so that the whole width of the page or slide is visible. 
All attendees have access to the Fit To Width button. 

• Actual Size: Clicking the Fit To Width button zooms the object in the Shared Objects pane 
so that it appears as actual size. 
All Attendees have access to the Actual Size button. 

• Stop Sharing: Clicking the stop sharing button will stop sharing the shared object currently 
displayed in the Shared Objects pane. 
Only the attendee sharing the object and attendees with Host status can use this control.  

The Pointer Tool 
Normally, other conference attendees are unable to see your mouse pointer. The pointer tool is a 
pointer that is visible to the other users, so it can be used to direct their attention to a specific 
location on the shared document or whiteboard. When you enable the pointer, the pointer cursor 
will appear underneath your regular mouse pointer, as if you were dragging it. Conference 
attendees will only be able to see the new pointer. 

The pointer tool is available only to attendees with Host or Presenter status. Click the pointer icon 
( ) to use the pointer tool. Click the arrow icon ( ) to turn it off. 
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Annotations 
The annotation tools provide a convenient way for attendees to draw or write a quick note in the 
conference. This feature works best with the whiteboard feature but can also be used with other 
sharing features (annotating documents and presentations). By default, only the Host and 
Presenters have rights to create annotations, but this right can be granted to other attendees. 

The annotation tool works with the following sharing features: 
• PowerPoint 
• Documents 
• Whiteboard 

How To Enable Annotation 

To enable the annotation feature, click the Annotate button ( ). This will show the 
annotation toolbar. 

How To Use The Annotation Tools 

The annotation tool is similar to drawing tools found in most graphics applications. Click the 
appropriate icon and add the desired element to the shared document or whiteboard.  

• Annotation Cursor: Annotation elements, including freehand lines created with the pencil or 
highlighter, are vector objects. They can be moved by selecting and dragging them with the 
annotation cursor. Also, you can delete an annotation element by selecting it with the cursor 
and pressing the Delete key. 

• Highlighter: A wide, translucent brush for highlighting.  

• Pencil: A narrow, opaque brush for creating freehand lines and 
doodles. 

• Shapes: A selection of shapes. Click and drag to create the 
shape. Use the Tool window to select a fill color, if desired. 

• Lines: A selection of lines and callouts. Click and drag to define 
the line. 

• Add Image: Click this icon to add an image as a notation. 
• Erase All: Erases all annotation elements. 
• Tool Window: Click this icon to access the tool window. With 

this window you can format your drawings’ elements and add 
text. Use the Color, Fill Color, (line) Width, and Opacity 
options to format elements selected with the cursor, and use the 
empty field at the bottom of the window to compose text. When 
you are satisfied with the text, click Paste Text to place it on the 
whiteboard or shared document.  
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Figure 42: Annotate Window 

Changing the Properties of an Annotation Element 
Users with annotation rights can change the properties of an annotation object through the options 
in the Tool Window.  

To modify an annotation element: 

1. Open the Tool windows by clicking the Tool Window button.  

2. Select the annotation cursor and use it to select the annotation element to be modified.  

3. Adjust the properties in the Tool window according to your needs. 

Granting Annotation Rights 

The Host can enable the annotation tools for other attendees in the conference.  

To grant annotation rights to an attendee: 

1. Right-click the user. 

2. Select Privileges from the context menu. 

3. Select Give Annotate.  

When the annotation rights are given to an attendee, the Annotate button will appear on that 
attendee’s toolbar. By clicking the Annotate button, the attendee can access the annotation toolbar 
and create annotations as per the instructions above. 
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The Recorder Tool 
You can use the recorder tool to record your presentation of shared objects. By default, the 
recorder tool creates a movie of a shared object in the conference, including any navigation or 
manipulation, and records the presence of the pointer tool. It does not record annotations. If 
multiple objects are shared in the conference, the recorder tool records the most recently shared 
object. However, using the Record Actual Desktop option, you may instead record an image of 
your desktop instead – such recordings will show annotations and the regular mouse pointer as you 
see them.  

You must have Host status to use the recorder tool. 

Configuring Your Assistant Collaboration Module for Recording 

If you are the user sharing objects and you wish to use the recorder, you must set the shared 
application loopback option. This option is found in the preferences. 

1. Click the File menu and select Options. 

2. Click the General tab. 

 
Figure 43: Your Assistant Collaboration Module Options, General Tab 

3. Check the Always loopback shared applications option. 

4. Click OK to confirm your changes. 

Using the Recording Tool 

To access the recording tool: 
• Click the Conference menu and select Record. The recording tool will appear. Note that the 

recording tool is only available to attendees with Host status. 
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Figure 44: Recording Tool 

Check that the finished file will meet your needs before you begin recoding. Change the following 
options as required: 

• Output File Format: The format for the finished recording. FLV files are compatible with the 
Your Assistant Collaboration Module Flash Player (see Playing your Recordings, below), and 
HTML files are compatible with web browsers, and WMV files are compatible with Windows® 
Media Player. You may select from additional file format options by enabling the Show Other 
Windows Formats checkbox. 

• Output Size: The image resolution of the finished recording. 
• Frames/Sec: You may select the maximum frames per second of the recording using this 

option. Note that the recording may capture fewer frames than the desired rate depending on 
your system resources; frame rate will be sacrificed for image quality if there are insufficient 
resources. 

• Output File: The file name for the finished recording. 
• Output Folder: The location for the finished recording. The default location for a recorded file 

is your desktop, but you select a different location by clicking the file browser icon ( ). 
• Windows Media Profile: The Windows Media Profile contains settings important to the 

recording tool. This option cannot be changed. 
• Show Other Windows Formats: Enabling this option makes AVI output file formats 

available. Tick the checkbox to gain access to various new file formats, and select one using 
the Output File Format list as required. 

• Record Actual Desktop: This option allows you to record your entire desktop, instead of just 
recording the shared object only. Enable this feature if you wish to see your annotations. 
Note that this option is only available if you have installed the Media Enhancement Drivers 
available through the Help menu. See Appendix C: Media Enhancement Drivers on page 66 
for more information. 



Your Assistant Collaboration Guide 
Version 3.3 

 

 40 

Note that because making recordings using this feature records an image of the desktop, it is 
useful to make the shared objects as large as possible on the desktop using this mode. 
Maximize shared applications, and enable Full Screen mode for shared documents and 
presentations to get the most benefit from recording a full desktop. 

To make a recording: 

1. Click the Record button ( ) to start your recording 

2. Click the Pause button ( ) to pause recording. Click Record again to continue. 

3. Click the Stop button ( ) to finish your recording and save the recording file. 

Playing your Recordings 

Your recordings are saved when you click the Stop button ( ). Recordings are saved in the file 
format defined by the Output File Format option, named according to the Output File option, and 
are saved in the directory defined by the Output Folder option. To play the recording, simply find 
the saved file and double click the file icon. The appropriate player (depends on the file format you 
selected) will open and the recording will play.  

If you have saved your recording as a .FLV file, the Your Assistant Collaboration Module Flash 
Player will open when you double click the file. 

 
Figure 45: Your Assistant Collaboration Module Flash Player 

The Flash Player will begin playing your .FLV file automatically. To access the play controls (play, 
pause, rewind, etc.), mouse over the minimized control panel ( ) in the upper left corner of the 
viewing area. The control panel will expand so that you may access the controls. 

Close the Flash Player by clicking the close button ( ), or select Exit from the File menu. 
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Chat 
The Chat feature is a great tool for users to communicate with each other without using the 
telephone. The chat tool offers advanced text formatting capabilities such as displaying text in rich 
text format, displaying images, hyperlinks, and drawings you create on the fly. Users can copy and 
paste text and images from other applications directly into the chat window.  

The Chat Window 
When you start the Your Assistant Collaboration Module, the Chat window will already be open in 
the left side of the application if default layout is used. By default, a chat session with all users is 
opened whenever a collaboration session is started. 

 
Figure 46: Sample Chat Window 

The Chat window provides a standard text chat interface. Compose messages in the workspace in 
the lower half of the window and click Send or press the Enter key to send the messages to the 
other attendees. The chat history is displayed in the upper portion of the window. 

The default chat interface is a simplified version of the Text Chat interface. You may access the full 
Text Chat interface as well as other chat features by disabling the Simple option. 

Simple 
The Simple option (default value: active) simplifies the chat interface, but reduces its features. 
Disabling this option brings up the Text Chat and Ink Chat tabs and toolbars. See Text Chat and Ink 
Chat, below, for more information. 

Enter 
The Enter option (default value: active) allows you to use the Enter key on your keyboard to send 
messages, just as if you had clicked the Send button. Disabling this option disables the keyboard 
shortcut, but allows you to use the Enter key to add line breaks to your messages instead. 

Text Chat and Ink Chat 

By default, the Your Assistant Collaboration Module opens with a simplified version of Text Chat. 
Disabling the Simple option brings up the Text Chat and Ink Chat toolbars. Note that in order to use 
Text Chat and Ink Chat effectively, you need to expand your workspace. Click and drag on the 
separator shown in the image below to expand your workspace. 
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Text Chat 
Text Chat is a standard chat function that allows you to send text messages as well as pasted text, 
images, or links. Click on the Text Chat tab to access Text Chat. 

 
Figure 47: Text Chat Window 

Select whatever text formatting options (font, size, bold, etc.) you need and compose your 
message in the workspace as normal. To choose a text color or paste text, an image, or link, click 

the more buttons icon ( ) at the end of the toolbar and select an option from the menu. When you 
are satisfied with your message, click Send. 

If you re-enable the Simple option after altering your text formatting, the Your Assistant 
Collaboration Module will remember your new text formatting and continue to use it when you 
compose new messages.  

Ink Chat 
Ink Chat allows you to create simple drawings to add to the chat session. Click on the Ink Chat tab 
to access Ink Chat. (Note: the Ink Chat tab may not appear if the workspace area is not large 
enough to display it. If you do not see the Ink Chat tab, expand the workspace). 

 
Figure 48: Ink Chat Window 

In Ink Chat, use the mouse to create images in the workspace. Select the color of your “pen” using 
the drop down list in the tool bar, and click the clear icon ( ) to erase the workspace if needed. 
When you are satisfied with your image, click Send. 

Starting and Stopping Chat Sessions 
By default, whenever you open the Your Assistant Collaboration Module, a chat session to all users 
is automatically started. However, you may start additional simultaneous chat sessions with select 
users, and stop (close) chat sessions individually. If you stop all your chat sessions, the Chat 
window will close. If you have multiple chat sessions, you may switch between them using the tabs 
at the bottom of the chat window. 
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Figure 49: Multiple Chat Session Tabs 

tarting a Chat Session 

Note that only a Host or Presenter can i

S

nitiate a chat session. 

1. From the Collaboration Module click the Share menu and select Chat. 

 
Figure 50: Share Chat Window 

2. The Share Chat window will appear. Using the radio buttons to select a chat preference. The 
choices are: 
o Chat with all users 
o Chat with Hosts only 
o Chat with Hosts and Presenters only 
o Chat with specific users 

chat session.  

Stop Chat button at the top right of the Chat 
 

ture is a true client/server application where all video streams are routed 

Any user in a conference with a PC-compatible video camera can send video. For best 
performance, a USB 2.0 compatible camera connected to a USB 2.0 port is highly recommended. 

If you select Chat w t the users you wish to participate 
from the list in the lower half of the window. 

ith specific users, you must selec

3. Click Start Chat to start the new 

Stopping a Chat Session 

You can stop (close) a chat session by cl
window. If you have multipl

icking the 
e chat sessions open, only the active chat session is closed. If you close

all the chat sessions, the Chat window will close.  

Videoconferencing  
The videoconferencing fea
through the conferencing server.  

The video stream from one attendee is sent to the conferencing server, and the server relays the 
video stream to all users in the conferencing session.  
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p 

g the 

r conference room camera which interfaces with the DirectShow 
X suite. This includes any of the following options: 

 input. 
ttached to a video card with a certified WDM 

f 
ference is affected by a webcam's ability to capture good 

o 
best quality 

re using a USB 2.0 camera 
sulting in less than 

Video co quires approximately 256 kbps for 320x240 resolution video at 20-30 

attendees that use video (i.e., that encode and transmit video to the web conferencing server) must 
r for a quality video conferencing experience. 

E

Requirements and Setu
Note that these requirements only apply to the attendee or attendees transmitting video in the 
conference. Conference attendees that are viewing but not transmitting video do not need to install 
any special software or hardware. 

To transmit video, you must have the following: 
• DirectX 8.1 or above. You can verify the version of DirectX on your computer by runnin

DXDIAG utility as described in the YA administration Guide. Note that DirectX 8.1 comes 
pre-installed with Windows XP. 

• A webcam, camcorder, o
component of the Direct
o A USB camera attached to the USB port on the computer. 
o A firewire camera attached to a firewire port. 
o A camcorder attached to a video card that offers a certified WDM driver and applicable 

connector like an S-video
o An external conference room camera a

driver. 
For the best video quality, you should use a good quality webcam or video camera. The quality o
the image transmitted to users in a con
quality images. For best video image quality, Mitel recommends using the Logitech Quickcam Pr
4000. This Logitech webcam model is USB 2.0 certified and produces one of the 
images in the Your Assistant Collaboration Module. Note that if you a

 at USB 1.x speed reand connect it to a USB 1.x port, the camera will operate
optimal video quality. You can verify if your computer supports USB 2.0 by checking the Windows 
Device Manager. 

Bandwidth Requirements 
nferencing re

frames/second (H263+ codec); and approximately 56 kbps for 176x144 resolution video at 1-5 fps. 
For sizing purposes, use 256 kpbs for standard conferencing. This should allow 320x240, 6 fps, 
both transmitting and receiving (i.e., a good user experience). Traffic is normally sustained during a 
video conference. Note that the Your Assistant Collaboration Module is easily capable of 
boardroom quality video conferencing using industry standard web cams. When set at full size, 
640x480, 30 fps, allow for approximately 384-512 kbps. IT administrators can limit this capability. 

WARNING: DSL and other asymmetric internet services may not offer full 256 kbps on the uplink; 

have full 256 kbps or bette

nabling Videoconferencing 

Your Assistant Collaboration Module has videoconferencing enabled by default. However, if 
videoconferencing is disabled for some reason, it may be re-enabled using the Your Assistant 
Collaboration Module options. 

1. Click the File menu and select Options. 

2. Click the Video tab. 
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Figure 51: Your Assistant Collaboration Module, Options, Video Tab 

3. Check the Enable Video option. 

4. Click OK to confirm your changes.  

Selecting your camera 

The Your Assistant Collaboration Module uses your system default camera as the video capture 
device for videoconferencing. If you have multiple cameras connected to your PC and do not want 
to use th efault despite 

era other than 

ns. 

b. 

Starting a Video-Enabled Conference 
creating any other type of conference. Simply 

al, and ensure that you do not disable the video option (video is 
one of the quick methods to create an ad-hoc 

tarting on page 5) for information on how to start 
conferences. 

e system default camera for videoconferencing, or if you have no system d
 camera, you may set the Your Assistant Collaboration Module to use a camhaving a

the system default. 

1. Click the File menu and select Optio

2. Click the Video ta

3. Select a camera option from the Capture Device list. 

4. Click OK to confirm your changes.  

Creating a videoconference is no different than 
create a conference as norm
enabled for all conferences by default). If you use 
conference, video will automatically be enabled. 

See the Managing Conferences section (s
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. If 
 

u or from the users list. Video streams may be 

The Video Pane 
nference, and is capable of handling multiple, 

n. 
ll appear automatically 

Activating Videoconferencing 

If you have an active camera, videoconferencing starts by default when you start a conference
the conference options specify that video should not start automatically at the beginning of the
conference, then an attendee with Host status must manually activate it. 

Video can be enabled from the Conference men
enabled for all attendees under a group, or on an individual basis. 

The video pane contains the video for the co
simultaneous video streams. The location of the video pane on your interface depends on what 
interface layout you are using, but typically the video will appear in the top left corner of the scree
The video pane will not be visible if no video streams are playing, but it wi
when video is active.  

 
Figure 52: Your Assistant Collaboration Module Video Pane 

The video pane contains the Video Style and Show Names options, and right-clicking on a video 
stream brings up a context menu which provides more options. 

Video Style 
The Video Style (default value: Best Fit) determines how the conference video streams are 
displayed. 

• Best Fit: multiple video streams are fitted into the display area. 

 
Figure 53: Your Assistant Collaboration Module, Best Fit Video Pane 

• Tabs: only one video stream will be displayed, although you may switch between multiple 
video streams using tabs. 
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Figure 54: Your Assistant Collaboration Module, Tabs Video Pane 

• Floating: each video stream will have its own independent window, which may be moved 
about and resized as required. 

 
Figure 55: Your Assistant Collaboration Module, Floating Video Panes 

Show Names 
The Show Names feature (default value: disabled) displays the name of conference attendee 
providing the video above their video stream. Note that in Floating video style, the name of the 
attendee providing the video stream is shown at the top of the window regardless of this option. 

Floating Video Streams Individually 

While the Floating video style option (see above) places all video streams in separate floating 
windows, you may also “float” video streams individually, so that some streams are floating and the 
rest remain in the video pane. 

Managing Video Streams 
ay control video playback. Video may be started, paused, and stopped (closed), and 

eo 
e 

Only a Host m
these actions may be applied to all video, video from certain groups, or from individual users. Vid
Streams can be controlled from the users list, from the Conference menu, and from the video pan
itself. 

Users List Video Icons 

The users list displays the status of each user’s video stream using icons. 

 
Figure 56: Your Assistant Collaboration Module Users List 
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e attendee can be green (The video icon to the right of th ), indicating that the attendee’s video 
stream is displayed, or grayed out ( ), which indicates that the attendee’s video stream is inactive. 

Starting or 

ideo stream causes the video captured by their camera to appear in the 
s. Each attendee’s video stream may be started independently, but you 

r Participants), or 
enable all streams. 

To start all attendees’ video streams: 
• Click the Conference menu and select Play All. 

To start a group’s video streams: 

1. Select 

If the attendee has no video icon to the right of their name, the attendee does not have a video 
capture device and is unable to stream video. 

Restarting Video Streams 

Starting an attendee’s v
video pane of all attendee
may also start video for all members in a status group (Hosts, Presenters, o

the group in the users list. 

2. Click the Play button ( ).  

OR 

1. Right-click the group in the users list. 

ndee in the users list. 

2. From the context menu, select Play Video.  

To start an individual attendee’s video stream: 

1. Select the atte

2. Click the Play button ( ).  

OR 

1. Right-click the attendee in the users list. 

y Video.  

Pausi video stream is the same as pausing a movie - you get a freeze frame of whatever is 
ams individually by attendee, by status group (Hosts, 

se all video streams. 

in the users list. 

2. From the context menu, select Pla

Pausing Video Streams 

ng a 
displayed at the time. You may pause the stre
Presenters, or Participants), or you may pau

To pause an individual attendee’s video stream: 

1. Select the attendee streaming the video 

2. Click the Pause button ( ).  

OR 

1. ck the attendee streaming the video in the users list. 

.  

o stream in the video pane (or the window if it is floating). 

Right-cli

2. From the context menu, select Pause Video

OR 

1. Right-click the vide

2. From the context menu, select Pause.  

To pause the video streams from all users in a group: 
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1. Select the group in the users list. 

2. Click the Pause button ( ).  

OR 

1. t-click the group in the users list. 

• Click the Conference menu and select Pause All. 

o disappear in the video pane of all attendees. Each 
endently, but you may also stop video for all 

cipants), or stop all video streams. 

ream: 

 the video in the users list. 

2.  the Stop button 

Righ

2. From the context menu, select Pause Video.  

To pause all video streams:  

Stopping (closing) Video Streams 

Stopping an attendee’s video stream causes it t
attendee’s video stream may be stopped indep
members in a status group (Hosts, Presenters, or Parti

To stop an individual attendee’s video st

1. Select the attendee streaming

Click ( ).  

the users list. 

, select Stop Video.  

r has its name shown (using the Show Names option), click the 

OR 

1. Right-click the attendee streaming the video in 

2. From the context menu

OR 
• If the video stream is floating o

close button ( ) at the upper right of the stream. 
To stop the video streams from all users in a group: 

1. Select the group in the users list. 

2. Click the Stop button ( ).  

OR 

1. Right-click the group in the users list. 

2.  the context menu, select Stop Video.  

All. 
Using nced Video Controls 

endees, stop transmitting your video 
rself, and videoconference with another 

rmally visible. Even after they become available, you must have 
Host status in order to use them. 

From

To stop all video streams:  
• Click the Conference menu and select Stop 

Adva

The Your Assistant Collaboration Module has optional advanced video controls that allow you to 
ignore video streams without stopping them for other att
stream to other users while continuing to watch it you
attendee without third-party attendees seeing them. 

Accessing Advanced Controls 
The advanced controls are not no

To access the advanced controls: 
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b in the Options window. 

 

nges.  

 

1. Click the File menu and select Options. 

2. Select the General ta

3. Check the Show advanced user controls option.

4. Click Okay to confirm your cha

The advanced controls will appear at the top of the users list. The new controls consist of the Show
/ Stop Showing button ( ) and the Watch / Stop Watching ( /  / ) button. 

 
Figure 57 w Advanced User Controls Window 

eo stream is playing. 

atching your own stream (the Stop Watching button 

: Your Assistant Collaboration Module, Sho
To view your video stream without transmitting it: 

1. Select yourself in the users list. Ensure that your vid

2. Set the Watch option so that you are w
( ) will be visible). 

(3. Set the Show option so that you are not showing your video stream (the Show button ) will 

Your video stream will disappear from the screens of other attendees, but will remain visible 
on yours. 

To close another attendee’s video stream on your screen without closing it for other attendees: 

1. Select an attendee other than yourself in the users list. Ensure that ream is 

ching their stream (the Watch button (

be visible). 

their video st
playing. 

2. Set the Watch option so that you are not wat ) will be 

3. Set the Show option so that you are not showing their video stream (the Show button 

visible). 

( ) will 

ill disappear from your screen, but will remain visible on theirs. 

will see it. Note that if it is active, your video stream will still be visible to all 

be visible). 

Their video stream w

To view another attendee’s video stream without it being available to third-party attendees:  

This feature is useful for privately conferencing with another attendee as part of a larger 
conference. Both you and the transmitting attendee can see their video stream, but no other 
attendees 
attendee. 

1. Select an attendee other than yourself in the users list. Ensure that their video stream is 
playing. 

2. Set the Watch option so that you are watching their stream (the Stop Watching button ( ) 
will be visible). 

3. Set the Show option so that you are not showing their video stream (the Show button ( ) will 
be visible). 



Your Assistant Collaboration Guide 
Version 3.3 

 

 51 

V
Each 
rate, a

Camera  and Properties 

 the camera software. 

vice: determines the video camera used in the conference. 

ation Module, but it is likely that it will contain settings such as contrast and 

rate, image resolution, and image quality. 

ed. The higher the 
dth is used.  

ls the resolution of the video viewing area for that video 
at 
z CPU 

 

of 
 

ent the Your Assistant Collaboration Module from 
u choose, the Collaboration Module will first sacrifice 

d demands. 

 

Their video stream will disappear from all third-party attendees’ screens. 

ideo Options and Preferences 
video stream has options and preferences to customize their source, image quality, frame 
nd size. Most options are available only to attendees with Host status. 

 Selection

You may choose the camera used to capture video for streaming, and change the camera 
properties using

• Right click a video stream, and select one of the following options from the context menu: 
o Capture De
o Properties: opens the camera properties window. The content of this window is 

camera-specific and is defined by the camera software rather than the Your Assistant 
Collabor
brightness levels. 

Image Resolution, Quality, and Frame Rate 

You may choose the maximum frame 
• Right click a video stream, and select one of the following options from the context menu: 

o Frames per Second: Determines the maximum FPS of the video fe
number the more bandwi

o Video Resolution: Contro
stream. The choices are 160x120, 176x144, 320x240, 352x288, although note th
larger view areas (above 320x240) are only available on faster computers (2 GH
or faster). The default is 320x240. Choosing a new resolution will force the video stream
to resize. 

o Quality: Quality sets the image quality of the video output, giving you the option 
having crisper video or using less bandwidth. The options are High, Medium and Low.
High produces the best quality and uses the most bandwidth. Low quality is light on 
bandwidth but quality is sacrificed. 

If insufficient system resources or bandwidth prev
meeting the quality and frame rate settings yo
frame rate, then image quality, until the available resources can meet the reduce

Changing All Video Streams 

You may change all video streams to a generic preset size and quality combinations, or change the
codec, resolution, or frames per second individually. 

• Click the Conference menu and select Change All Video To…  
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Figure 58: Your Assistant Collaboration Module, Conference Submenu 

A submenu will appear, presenting a number of video options.  

Selecting Presets 
You may change all video streams to one of three generic preset size and quality combinations, 
making : 

20x240, 6 frames per second) 

reams. In most situations, this will have little 
 certain circumstances 

re configurations. 

age quality, and size settings available to individual video streams (see above) 
lied to all video streams. 

y Feature 

 override the default settings imposed by the Your Assistant 

 stream, resulting in a better frame rate or image quality.  

ot designed for novices. Unless you have knowledge of the bandwidth 
between the conferencing server to each attendee in the conference and the capabilities of each 

 all video streams uniform in appearance. The following options are available
• Good Video (320x240, 15 frames per second) 
• Fair Video (3
• Low Video (176x144, 3 frames per second) 

Video Codec 
You may change the video codec used for all video st

may be useful ineffect on the conference, but changing the codec 
depending on the attendees’ hardware and softwa

Your options are: 
• H.263+ 
• MPEG4 

Image size, Quality, and Frame Rate 
The frame rate, im
may also be app

The Video Priorit

The video priority feature allows you to
Collaboration Module when the video feature is enabled. Using this feature, you can increase the 
priority of assigning resources to the video

The video priority setting is n

attendee’s computer, you should leave the video priority setting alone and allow the conferencing 
software to optimize the video settings automatically. 

To change the video priority setting: 

1. Click the File menu and select Options. 

2. Select Video Out tab from the dialog 
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Figure 59: Your Assistant Collaboration Module, Video Out Tab 

3. Enable the Video Priority feature by checking the checkbox  

4. Use the slider to define the Video Priority. The higher the priority, the more resources will be 
devoted to the video streams, and the better your video quality will be. 

you. If you have a 
higher setting and this will 

of bandwidth or 
insuff
the ch
Modu

T

ucing 

d select Quality from the context menu. 

frame rate. 
r second). Reduce the 

laying Video 

t your camera’s field of view is not obstructed (particularly if it 
solutions: 

If yo
faster PC, like a 3 GHz CPU computer, you can consider using a 

ur computer has a 2 GHz CPU, the Normal Position will work well for 

allow you to use the 640 x 480 video size setting at 10 or 15 FPS. 

In the event you experience video syncing issues, whether it results from a lack 
icient computer processing resources, you can revert the settings back to Low and uncheck 
eckbox to turn off the Video Priority feature. This returns the Your Assistant Collaboration 
le to its default state and allows it to adjust the video automatically. 

roubleshooting Videoconferencing 
When using the video conferencing feature, you can improve the quality and experience by 
following the recommendations below: 

Improving Frame Rate 

The most reliable way to improve frame rate is to reduce the quality of the video image. By red
the image quality from high to medium, you can reduce the bandwidth usage by 50%. 

1. Right click on the image an

2. Select a lower quality setting.  

Another method to potentially improve the actual frame rate is to reduce the maximum 
The default frame rate in a video conference session is 10 FPS (frames pe
FPS from 10 to 8, 7 or even 5 FPS if needed. To reduce the FPS:  

1. Right click on the video image. 

2. Select Frames Per Second. 

3. Select the desired FPS value.  

Correcting Unresponsive or Non-Disp

The first thing to always check is tha
has a lens cap!). Otherwise, attempt the following 



Your Assistant Collaboration Guide 
Version 3.3 

 

 54 

d capture device is the appropriate camera. 

tX on your workstation is version 8 or higher. Your DirectX 
nistrator Guide for more 
ctX.  

wns. 

Lea
 no longer 

onference also removes the conference from the 
 attendees, not just you. 

L

s have the ability to leave a conference. Whenever an attendee leaves a 
ees are notified with a popup and alert noise. These notifications may 

Notification Options on page 63 for more information. 

Verify your Capture Device selection 
1. Click the File menu. 

2. Select Options. The Options dialog will appear. 

3. Select the Video Device tab. 

4. Ensure that the selecte

Verify your DirectX version 
Check to ensure the version of Direc
version can be determined by running the DXDIAG utility; see The YA Admi
information. If you do not have the DXDIAG utility, you need to install Dire

Verify your camera drivers 
Make sure you have the latest drivers for the webcam. Visit the manufacturer's website to obtain 
the latest drivers, if required. If your workstation has drivers for multiple cameras, uninstall the 
drivers for cameras that you no longer use as they may be the source of slowdo

ving and Ending Conferences 
Leaving a conference and ending a conference have the same superficial effect -- you
participate in the conference. However, ending a c
server, meaning that the conference is over for all

Any attendee can leave a conference at their convenience. Only users with Host status can end a 
conference.  

eaving a Conference 
Leaving a conference removes you as an attendee and exits the Your Assistant Collaboration 
Module. All attendee
conference, all other attend
be customized or disabled; see 

 
Figure 60:  Conference Notification 

Note that even if all attendees have left the conference, the conference will persist on the server 
until it is ended. This way, the conference may be re-joined later. 

To leave a conference: 

E
s the Your Assistant Collaboration 
 effectively ending the conference for all 

ence is ended, no new attendees can join.  

• Click the File menu and select Leave Conference. 

nding a Conference 
Ending a conference removes you as an attendee and exit
Module, but it also removes the conference from the server,
attendees. Once a confer

To end a conference: 
• Click the File menu and select End Conference. 
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nference you created without entering the conference. This may be done 
YA Meetings List; see 

You may also end a co
from the Your Assistant Collaboration Module web page or from the 
Managing Conferences on page 5 for more details. 
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Appendix A: Options 
The Your Assistant Collaboration Module is highly customizable; individual features may be 
enabled and disabled and their quality adjusted, and aspects of the interface may be altered to suit 
your needs. Customization options are accessed using the Options window. 

System Rating 
While your System Rating contains no options, it is useful in providing an idea of your workstation’s 
performance. This allows you to make an educated decision on whether or not you wish to enable 
certain features or increase video or sharing quality.   

 
Figure 61: Your Assistant Collaboration Module, System Rating 

To view your system rating, mouse over the five-bar icon along the bottom of the Your Assistant 
Collaboration Module interface. A System Rating popup will appear. 

Your workstation is rated one (worst) to five (best) bars. If your workstation rates five bars, you 
should be able to have high quality video and sharing without sacrificing much in the way of frame 
rate. Lower rated systems must compromise. A workstation rated at one bar or two bars will likely 
have a low frame rate while sharing regardless of the sharing quality.  

Options 
The settings in the Options window allow the user to control features in their conferencing client and 
ultimately their conferencing session. The Options window is accessible from the File menu. Click 
the File menu and selection Options. 
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General Options 

 
Figure 62: Your Assistant Collaboration Module, Options Window, General Tab 

Name 

By default, the Collaboration Module will use your Windows logon name as the visual identity in a 
conference. This option allows attendees to set their own screen names in the event their logon 
name is ambiguous. 

Settings 

The options under the Settings menu allow you to expose some of the advanced features in the 
Collaboration Module. 

Adjust Video Splitters for Best Fit  
Since each video feed can have a different display size, this option forces the Collaboration 
Module to automatically size the vertical splitter to the largest video display in a multi video 
conferencing session. It is useful when viewing multiple video streams in “best fit” mode. 

This option is active by default. 

Show Tab for Shared Applications  
This option forces the Collaboration Module to display tabs at the bottom of the shared 
application. It is useful when sharing multiple applications. 

This option is disabled by default. 

Always Loopback Shared Applications  
This option causes your shared object to be looped back into the shared region space. It is 
required when using the recording feature while using a sharing feature. 

This option is disabled by default. 
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Show Advanced User Controls  
This feature exposes the advance controls for setting the video settings in the Collaboration 
Module. See Using Advanced Video Controls on page 49 for more information on these 
controls. 

This option is disabled by default. 

All Undock and Drag  
This option allows the user to manually control and move portions of the user interface off the 
main parent window. It is useful for computers using the multi monitor setup. 

This option is disabled by default. 

Share Printed Documents Automatically  
When checked, documents sent to the Mitel Printer are automatically displayed in a 
document sharing window. Enabling this option also installs the Mitel Printer if it has not 
already been installed. 

This option is disabled by default. 

Sharing Options 

 
Figure 63: Your Assistant Collaboration Module, Options Window, Sharing Tab 

Document 

The document quality setting affects the resolution of shared documents and PowerPoint 
presentations. A higher quality setting will produce a crisper shared image of the document or 
presentation, but will require more resources to share.  

Desktop 

The desktop quality settings affect shared desktops and applications. 
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Sharing Quality 
This slider sets the quality of image for a shared application or desktop. A higher quality 
setting produces a crisper image, but requires more resources. If there are insufficient 
system or server resources, the Collaboration Module will sacrifice frame rate in order to 
attempt to maintain the image quality.  

Sharing Frames Per Second 
This slider sets the maximum frames per second for shared desktops and applications. A 
higher frames per second maximum produces smoother editing and cursor movement, but 
requires more resources. If there are insufficient system or server resources, frame rate is 
the first thing to be sacrificed. 

Use CAPTUREBLT 
CAPTUREBLT is an application program interface (API) designed to capture all screen 
changes, including mouse movement, in Windows. Enabling CAPTUREBLT improves the 
shared desktop feature. However, not all video cards/drivers support CAPTUREBLT. If your 
video driver is out date or if it does not support the CAPTUREBLT API, enabling this option 
will cause problems. 

This option is disabled by default. If you use an older workstation and are unsure if your video 
drivers support the CAPTUREBLT API, contact your system administrator before enabling 
this option.  

Video Options 

 
Figure 64: Your Assistant Collaboration Module, Options Window, Video Tab 

General 

The Enable Video option allows the user to use a webcam or other approved cameras to transmit 
video for videoconferencing. This option is checked by default. 
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Device 

The capture device setting defines which video capture device the workstation will use to capture 
video for videoconferencing. By default, this is set to the Windows default capture device. 

Video Out Options 

 
Figure 65: Your Assistant Collaboration Module, Options Window, Video Out Tab 

Priority 

While there are two controls here (a checkbox and a slider), it is part of the same option; the 
checkbox enables the Priority slider. By increasing video priority, one can increase the priority of 
assigning resources to the video stream, resulting in a better frame rate or image quality. However, 
increasing video priority has the potential to reduce the performance of non-video aspects of the 
conference. See The Video Priority Feature on page 52 for more information. 

This option is disabled by default. It is recommended that this option be left disabled unless the 
consequences of increasing video priority are understood. 
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Language and Local Options  

 
Figure 66: Your Assistant Collaboration Module, Options Window, Language and Locale Tab 

Language 

Use Windows default language 
When this option is selected, the Your Assistant Collaboration Module uses the Windows 
default language as the language for the Collaboration Module interface. 

This option is active by default. 

Language 
If you choose not to use the Windows default language (as per the option above), select a 
language for the interface using the Language combo box. 
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Hotkey Options  

 
Figure 67: Your Assistant Collaboration Module, Options Window, Hotkeys Tab 

Apply My Layout 

Use this key command to apply your interface layout to all other attendees. 

Stop Sharing 

Use this key combination to stop sharing an object you are currently sharing. If you are sharing 
multiple objects, the stop sharing command will apply to the active shared object.  

Stop Remote Control 

Use this key combination to end remote control. This hotkey is applicable regardless if you are the 
controller or the controllee. 
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Notification Options 

 
Figure 68: Your Assistant Collaboration Module, Options Window, Notify Tab 

Popups 

The popup options allow you to define when notification popups appear. 

Sounds 

The sound options allow you to define if notification sounds are played for certain events, and what 
sounds files are used. 

Play sound when user joins 
This feature plays a sound whenever an attendee joins a conference. You may customize the 
sound as desired by typing in a new file path into the text box, or using the file browser by 
clicking the Open button ( ). You may also play the sound file by clicking the Play button 
( ). This feature is enabled by default. 

Play sound when user leaves 
This feature plays a sound whenever an attendee leaves a conference. You may customize 
the sound as desired by typing in a new file path into the text box, or using the file browser by 
clicking the Open button ( ). You may also play the sound file by clicking the Play button 
( ). This feature is enabled by default. 

Play sound for chat messages 
This feature plays a sound whenever a new message is added to an active chat session. You 
may customize the sound as desired by typing in a new file path into the text box, or using the 
file browser by clicking the Open button ( ). You may also play the sound file by clicking the 
Play button ( ). This feature is enabled by default. 
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Appendix B: The Bandwidth Monitor 
The Your Assistant Collaboration Module includes a Bandwidth Monitor tool to aid you in tracking 
how much bandwidth your conference requires, and how each aspect of a conference affects your 
bandwidth requirement. 

To access the Bandwidth Monitor: 

1. Start the Your Assistant Collaboration Module by joining or creating a conference. The 
conference does not need to have other attendees - you just need access to the Your 
Assistant Collaboration Module interface. 

2. Click the Help menu and select Bandwidth Monitor. The Bandwidth Monitor will appear. 

 
Figure 69: Your Assistant Collaboration Module, Bandwidth Monitor 

The Bandwidth Monitor displays a number of gauges that display bandwidth usage. All gauges 
measure usage in kilobytes per second. 

Total Usage: An instantaneous measure of the total bandwidth used by the Your Assistant 
Collaboration Module. 

Total Bandwidth Usage History: A graph of bandwidth usage over time. To select the 
maximum value of the graph’s Y coordinate, select one of the radio button options above the 
graph. 

Video: Displays bandwidth devoted to your video stream, if you are displaying one. 

Audio: Displays bandwidth devoted to audio transmission. However, as audio transmissions 
are covered by Mitel Your Assistant rather than the Your Assistant Collaboration Module, this 
gauge will not have much to display. 

Document: Displays bandwidth devoted to sharing documents or presentations. 

Desktop: Displays bandwidth devoted to sharing your desktop, regions of your desktop, or 
applications. 
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Peak Usage: A record of the peak bandwidth usage in each category. The values are reset 
each time you open the Bandwidth Monitor. 

Stay on Top: This option prevents the Your Assistant Collaboration Module from obscuring 
the Bandwidth Monitor when the Collaboration Module has focus. It does not prevent other 
applications from obscuring the Bandwidth Monitor, however. 

Close: Click this button to close the application. 
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Appendix C: Media Enhancement Drivers 
The Media Enhancement Drivers are an optional set of drivers that can be installed from the Your 
Assistant Collaboration Module interface. The Media Enhancement Drivers allow you to record 
your entire desktop with the Recording tool without sharing your entire desktop. 

Installing the Media Enhancement Drivers  

In order to install the Media Enhancement Drivers, you must be logged in with administrative 
access to your workstation. Once you have administrative access, use the following procedure to 
install the drivers: 

1. Start the Your Assistant Collaboration Module by joining or creating a conference. The 
conference does not need to have other attendees - you just need access to the Your 
Assistant Collaboration Module interface. 

2. Click the Help menu and select Install Media Enhancement Drivers. If this option does not 
appear, the Media Enhancement Drivers are already installed. 

3. The Media Enhancement Display Driver Setup Wizard will appear. Follow the instructions in 
the wizard to install the drivers. 

 
Figure 70: Your Assistant Collaboration Module, Media Enhancement Display Driver 

4. During the installation you will receive a pair of Windows warnings stating that the drivers 
have failed Windows Logo testing. These may be ignored; click Continue Anyway to 
continue to install the drivers. You do not need to restart your workstation once the drivers 
are installed for them to take effect. 

Uninstalling the Media Enhancement Drivers 

While there are no know conflicts or issues with the Media Enhancement Drivers, you may desire to 
uninstall them at some point. Like most things installed under Microsoft® Windows, The Media 
Enhancement Drivers can be uninstalled using the Add or Remove Programs utility. 

1. Click the Windows Start Menu and select Settings. In the submenu, select Control Panel. 

2. The Control Panel will open. Double click Add or Remove Programs. 

3. The Add or Remove Programs utility will open. Select the Change or Remove Programs 
button on the left side of the interface, if it is not already selected. 
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Figure 71: Windows, Add or Remove Programs Window 

4. Scroll through the list of currently installed programs until you find Media Enhancement 
Display Driver 1.0.72.0. Select the driver and click the Remove button. 

5. A confirmation will appear - click Yes to continue. Once the uninstall is complete, you will 
need to restart your workstation before it can take full effect.  
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